User Manual

netLINK NL 50-MPI and netTAP NT 50-MPI

Installation, Operation and Hardware Description

Hilscher Gesellschaft für Systemautomation mbH

www.hilscher.com

DOC080604UM06EN | Revision 6 | English | 2012-03 | Released | Public
Table of Contents

1 INTRODUCTION ......................................................................................................... 5
  1.1 About the User Manual ............................................................................................ 5
      1.1.1 List of Revisions ................................................................................................. 5
      1.1.2 Reference to Hardware ........................................................................................ 6
      1.1.3 Reference to Firmware ....................................................................................... 6
      1.1.4 Reference to SyCon Software ............................................................................. 6
      1.1.5 Conventions in this Manual ................................................................................ 6
  1.2 Contents of the Product DVD .................................................................................. 7
      1.2.1 Directory Structure of the DVD ......................................................................... 7
      1.2.2 Overview of relevant Documentation ............................................................... 8
  1.3 Legal Notes ............................................................................................................ 9
      1.3.1 Copyright ........................................................................................................... 9
      1.3.2 Important notes ................................................................................................. 9
      1.3.3 Exclusion of liability ......................................................................................... 10
      1.3.4 Warranty .......................................................................................................... 10
      1.3.5 Export Regulations ......................................................................................... 11
      1.3.6 Registered Trademarks ................................................................................... 11
  1.4 Licenses ................................................................................................................ 11

2 SAFETY ...................................................................................................................... 12
  2.1 Safety Notes .......................................................................................................... 12
  2.2 Intended Use .......................................................................................................... 12
  2.3 Personnel Qualification ......................................................................................... 12
  2.4 Labeling of Safety Instructions .............................................................................. 13
  2.5 Safety Instructions ................................................................................................ 14
      2.5.1 Electrical Voltage .............................................................................................. 14
      2.5.2 Electrostatic Discharge ..................................................................................... 14
  2.6 Safety Instructions USA ........................................................................................ 15
      2.6.1 Electrical Current ............................................................................................ 15
      2.6.2 Electrostatic Discharge .................................................................................... 15

3 DESCRIPTION AND REQUIREMENTS ...................................................................... 16
  3.1 Description ............................................................................................................ 16
      3.1.1 Description netLINK NL 50-MPI ....................................................................... 16
      3.1.2 Compatibility of the netLINK NL 50-MPI to the NL-MPI ................................ 16
      3.1.3 Description netTAP NT 50-MPI ......................................................................... 17
      3.1.4 Compatibility of the netTAP NT 50-MPI to the NT 40-MPI ............................... 17
  3.2 System Requirements ............................................................................................. 17
  3.3 Preconditions for Operation .................................................................................. 18

4 DEVICE DRAWING AND CONNECTIONS .............................................................. 19
  4.1 Device and Dimensioned Drawing ......................................................................... 19
  4.2 Connections and LEDs ......................................................................................... 20
  4.3 Ethernet Interface (X3) .......................................................................................... 21
      4.3.1 Ethernet pinning at the RJ45 Socket ................................................................. 21
      4.3.2 Ethernet Connection Data ............................................................................... 21
1 Introduction

1.1 About the User Manual

This user manual contains a description for

- the netLINK NL 50-MPI device and for
- the netTAP NT 50-MPI device

with an integrated netX 50 communication controller. The netLINK NL 50-MPI device is a successor of the netLINK NL-MPI and netTAP NT 50-MPI device is a successor of the netTAP NT 40-MPI device.

This user manual contains information for commissioning and use of the both MPI devices.

1.1.1 List of Revisions

<table>
<thead>
<tr>
<th>Index</th>
<th>Date</th>
<th>Chapter</th>
<th>Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>2009-06-07</td>
<td>1.1.2</td>
<td>Hardware revision 4 added</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.1.3</td>
<td>Firmware V2.004 added</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.1.4</td>
<td>Reference on SyCon Software added</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3.3. 5.3.1</td>
<td>PROFIBUS interface is isolated from hardware revision 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.4</td>
<td>Name of Pin 2 and 5 for the hardware revision</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10.1</td>
<td>PROFIBUS interface is isolated from hardware revision 4</td>
</tr>
<tr>
<td>5</td>
<td>2011-09-13</td>
<td>1.1.3</td>
<td>Section Reference to Firmware updated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3.3</td>
<td>Section Preconditions for Operation: Windows® Vista and Windows® 7 added, DVD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.1</td>
<td>Section Installing Software from DVD updated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8.2</td>
<td>Section Ethernet Failure in 10 MBit/s Half Duplex Mode and Workaround added</td>
</tr>
<tr>
<td></td>
<td></td>
<td>13.2</td>
<td>Section Disposal of Waste Electronic Equipment added</td>
</tr>
<tr>
<td>6</td>
<td>2012-03-01</td>
<td>all</td>
<td>netTAP NT 50-MPI device description added</td>
</tr>
</tbody>
</table>

Table 1: List of Revisions
1.1.2 Reference to Hardware

<table>
<thead>
<tr>
<th>Device</th>
<th>Hardware Revision</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>NL 50-MPI</td>
<td>Revision 2,</td>
<td>1701.430</td>
</tr>
<tr>
<td></td>
<td>Revision 3,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Revision 4</td>
<td></td>
</tr>
<tr>
<td>NT 50-MPI</td>
<td>Revision 1</td>
<td>1758.111</td>
</tr>
</tbody>
</table>

Table 2: Reference to Hardware

1.1.3 Reference to Firmware

<table>
<thead>
<tr>
<th>Firmware</th>
<th>Version</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>nl50mpi.e50</td>
<td>V02.147</td>
<td>This firmware can be used for the NL 50-MPI and for the NT 50-MPI device.</td>
</tr>
</tbody>
</table>

Table 3: Reference to Firmware

1.1.4 Reference to SyCon Software

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBHnet Driver</td>
<td>1.48</td>
<td></td>
</tr>
<tr>
<td>SyConMPI</td>
<td>2.961 (Installation)</td>
<td></td>
</tr>
</tbody>
</table>

Table 4: Reference to SyConMPI Software

1.1.5 Conventions in this Manual

Operating Instructions, a result of an operation step or notes are marked as follows:

Operating Instructions:

- <instruction>
  or

1. <instruction>
2. <instruction>

Results:

° <result>

Notes:

Note: <note>

Positions in Figures

The Positions 1, 2, 3 ... or 2, 3, 4 ... or A, B, C ... refer to the figure used in that section. If the numbers reference to a section outside the current section then a cross reference to that section and figure is indicated.
1.2 Contents of the Product DVD

The Product DVD for the netLINK contains:

- Documentation
- STEP 7® Driver IBHnet
- System Configurator SyConMPI
- Hilscher IP driver

1.2.1 Directory Structure of the DVD

All manuals on this DVD are delivered in the Adobe Acrobat® Reader format (PDF).

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>Files for the configuration and communication interface (API) of the netLINK NL 50-MPI device and the netTAP NT 50-MPI device.</td>
</tr>
<tr>
<td>Documentation</td>
<td>Documentation in the Acrobat® Reader Format (PDF).</td>
</tr>
<tr>
<td>EDS</td>
<td>Files needed from SyConMPI during installation.</td>
</tr>
<tr>
<td>Firmware</td>
<td>Loadable Firmware.</td>
</tr>
<tr>
<td>fscommand</td>
<td>Installation support routines used during the installation process.</td>
</tr>
<tr>
<td>IBHnet</td>
<td>STEP 7 driver IBHnet setup program.</td>
</tr>
<tr>
<td>Sycon</td>
<td>System Configurator SyConMPI (configuration software) Setup program.</td>
</tr>
<tr>
<td>TcpUdplpDriver</td>
<td>Setup program for the Hilscher IP Driver.</td>
</tr>
</tbody>
</table>

Table 5: Directory Structure of the DVD
1.2.2 Overview of relevant Documentation

The following documentation overview gives information, for which items you can find further information in which manual.

**Documentation for Users**

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
<th>Document name</th>
</tr>
</thead>
<tbody>
<tr>
<td>netLINK NL 50-MPI and netTAP NT 50-MPI</td>
<td>Installation, Operation and Hardware Description</td>
<td>netLINK NL 50-MPI and netTAP NT 50-MPI UM xx EN.pdf (this document)</td>
</tr>
<tr>
<td>IBHNet</td>
<td>Describes the installation and configuration of the STEP®7 driver IBHnet for the use of the NL 50-MPI and the NT 50-MPI device as PG interface with Simatic® STEP® 7. The netLINK NL 50-MPI device is designated as IBH Link S7++.</td>
<td>IBHNet_Manual.pdf This description was created by IBHsoftec Gesellschaft für Automatisierungstechnik mbH.</td>
</tr>
<tr>
<td>SyConMPI</td>
<td>Description of the configuration software SyConMPI</td>
<td>SyConMPI OI xx EN.pdf</td>
</tr>
</tbody>
</table>

*Table 6: Documentations for Users*

For the configuration of the MPI device the configuration software SyConMPI or the IBHnet driver can be used.

**Documentation for Developers**

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
<th>Document name</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Driver</td>
<td>Description of the Hilscher IP driver</td>
<td>Drv_ip.pdf</td>
</tr>
<tr>
<td>MPI Protocol Interface Manual</td>
<td>Description of the netLINK MPI protocol interface (for both devices)</td>
<td>netLINK_MPI_Protocol_API_en.pdf</td>
</tr>
<tr>
<td>FDL Protocol Interface Manual</td>
<td>Description of the netLINK FDL protocol interface (for both devices)</td>
<td>netLINK_FDL_Protocol_API_en.pdf</td>
</tr>
</tbody>
</table>

*Table 7: Documentations for Developers*
1.3 Legal Notes

1.3.1 Copyright

© Hilscher, 2008-2012, Hilscher Gesellschaft für Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying material (user manual, accompanying texts, documentation, etc.) are protected by German and international copyright law as well as international trade and protection provisions. You are not authorized to duplicate these in whole or in part using technical or mechanical methods (printing, photocopying or other methods), to manipulate or transfer using electronic systems without prior written consent. You are not permitted to make changes to copyright notices, markings, trademarks or ownership declarations. The included diagrams do not take the patent situation into account. The company names and product descriptions included in this document may be trademarks or brands of the respective owners and may be trademarked or patented. Any form of further use requires the explicit consent of the respective rights owner.

1.3.2 Important notes

The user manual, accompanying texts and the documentation were created for the use of the products by qualified experts, however, errors cannot be ruled out. For this reason, no guarantee can be made and neither juristic responsibility for erroneous information nor any liability can be assumed. Descriptions, accompanying texts and documentation included in the user manual do not present a guarantee nor any information about proper use as stipulated in the contract or a warranted feature. It cannot be ruled out that the user manual, the accompanying texts and the documentation do not correspond exactly to the described features, standards or other data of the delivered product. No warranty or guarantee regarding the correctness or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well as related user manuals, accompanying texts and documentation at all times and without advance notice, without obligation to report the change. Changes will be included in future manuals and do not constitute any obligations. There is no entitlement to revisions of delivered documents. The manual delivered with the product applies.

Hilscher Gesellschaft für Systemautomation mbH is not liable under any circumstances for direct, indirect, incidental or follow-on damage or loss of earnings resulting from the use of the information contained in this publication.
1.3.3 Exclusion of liability

The delivered product (including the technical data) is subject to export or import laws as well as the associated regulations of different counters, in particular those of Germany and the USA. The software may not be exported to countries where this is prohibited by the United States Export Administration Act and its additional provisions. You are obligated to comply with the regulations at your personal responsibility. We wish to inform you that you may require permission from state authorities to export, re-export or import the product.

1.3.4 Warranty

Although the hardware and software was developed with utmost care and tested intensively, Hilscher Gesellschaft für Systemautomation mbH does not guarantee its suitability for any purpose not confirmed in writing. It cannot be guaranteed that the hardware and software will meet your requirements, that the use of the software operates without interruption and that the software is free of errors. No guarantee is made regarding infringements, violations of patents, rights of ownership or the freedom from interference by third parties. No additional guarantees or assurances are made regarding marketability, freedom of defect of title, integration or usability for certain purposes unless they are required in accordance with the law and cannot be limited. Warranty claims are limited to the right to claim rectification.
1.3.5 Export Regulations

The delivered product (including the technical data) is subject to export or import laws as well as the associated regulations of different counters, in particular those of Germany and the USA. The software may not be exported to countries where this is prohibited by the United States Export Administration Act and its additional provisions. You are obligated to comply with the regulations at your personal responsibility. We wish to inform you that you may require permission from state authorities to export, re-export or import the product.

1.3.6 Registered Trademarks

Windows® XP/Windows® Vista/Windows® 7 are registered trademarks of Microsoft Corporation.
Acrobat® is a registered trademark of Adobe Systems, Inc in the USA and further countries.
Pentium® is a registered trademark of Intel Corporation in the USA and further countries.
S7, S7-300, S7-400 and MPI are registered trademarks of Siemens AG, Berlin and Munich.

1.4 Licenses

The netLINK NL 50-MPI device and the netTAP NT 50-MPI device contain a license for the use with the IBHnet driver.
2 Safety

2.1 Safety Notes

The user manual, accompanying texts and the documentation were created for the use of the products by qualified experts. When using the products, all safety notes and applicable regulations must be observed. Technical knowledge is required. The user must comply with legal provisions.

2.2 Intended Use

The netLINK NL 50-MPI and the NT 50-MPI may only be used as a part of a communication system as described in this manual. The device has been designed exclusively for use in connection with the S7-300 und S7-400 PLCs manufactured by Siemens AG.

The device may not be opened or be used when the housing has been removed.

2.3 Personnel Qualification

The NL 50-MPI and the NT 50-MPI devices are used as a part of a system which must fulfill safety and accident precaution regulations depending on the respective conditions of use. The user of the system is exclusively responsible for the fulfillment of those regulations.

Therefore the system to which the netLINK NL 50-MPI device respectively netTAP NT 50-MPI device belongs may only be used by personnel who has been informed and educated about all relevant regulations.
2.4 Labeling of Safety Instructions

The safety instructions are pinpointed particularly. The instructions are highlighted with a specific safety symbol, a warning triangle and a signal word according to the degree of endangerment. Inside the note the danger is exactly named. Instructions to a property damage message do not contain a warning triangle.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Sort of Warning or Principle</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>Safety symbol for the warning to personal injury</td>
</tr>
<tr>
<td><img src="image" alt="Warning Triangle" /></td>
<td>Warning of damages by electrostatic discharge</td>
</tr>
</tbody>
</table>

Table 8: Safety Symbols and Sort of Warning or Principle

2.4.1.1 Signal Words

<table>
<thead>
<tr>
<th>Signal Word</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER</td>
<td>indicates a direct hazard with high risk, which will have as consequence death or grievous bodily harm if it isn't avoided. The use of this signal word shall be restricted to extremely hazard.</td>
</tr>
<tr>
<td>WARNING</td>
<td>indicates a possible hazard with medium risk, which will have as consequence death or (grievous) bodily harm if it isn't avoided.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>indicates a minor hazard with medium risk, which could have as consequence simple battery if it isn't avoided.</td>
</tr>
<tr>
<td>Note</td>
<td>Indicates an important note in the manual.</td>
</tr>
</tbody>
</table>

Table 9: Signal Words

2.4.1.2 Signal Words USA

<table>
<thead>
<tr>
<th>Signal Word</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER</td>
<td>Indicates a Hazardous Situation Which, if not Avoided, will Result in Death or Serious Injury.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Indicates a Hazardous Situation Which, if not Avoided, could Result in Death or Serious Injury.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>Indicates a Hazardous Situation Which, if not Avoided, may Result in Minor or Moderate Injury.</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Indicates a Property Damage Message.</td>
</tr>
<tr>
<td>Note</td>
<td>Indicates an Important Note in the Manual.</td>
</tr>
</tbody>
</table>

Table 10: Signal Words according to ANSI
2.5 Safety Instructions

This manual contains instructions which must be observed to ensure your own personal safety and to avoid damage to devices of your system.

2.5.1 Electrical Voltage

Device Destruction!

- Use only 18 ... 30 V supply voltage to operate the devices. Operation with more than 30 V supply voltage will lead to destruction of the device.

2.5.2 Electrostatic Discharge

Adhere to the necessary safety precautions for components that are vulnerable with electrostatic discharge (EN 61340-5-1 und EN 61340-5-2 as well as IEC 61340-5-1 und IEC 61340-5-2).

Electrostatic Discharge

This equipment is sensitive to electrostatic discharge, which cause internal damage and affect normal operation. Follow guidelines when you handle this equipment:

- Touch a grounded object to discharge potential static.
- Do not touch connectors or pins.
- Do not touch circuit components inside the equipment.
- When not in use, store the equipment in appropriate static-safe packaging.
2.6 Safety Instructions USA

This manual contains instructions which must be observed to ensure your own personal safety and to avoid damage to devices.

2.6.1 Electrical Current

Device Destruction!

- Use only 18..30 V supply voltage to operate the devices.
  Operation with more than 30 V supply voltage will lead to destruction of the device.

2.6.2 Electrostatic Discharge

Adhere to the necessary safety precautions for components that are vulnerable with electrostatic discharge (EN 61340-5-1 und EN 61340-5-2 as well as IEC 61340-5-1 und IEC 61340-5-2).

Electrostatic Discharge

This equipment is sensitive to electrostatic discharge, which cause internal damage and affect normal operation. Follow guidelines when you handle this equipment:

- Touch a grounded object to discharge potential static.
- Do not touch connectors or pins.
- Do not touch circuit components inside the equipment.
- When not in use, store the equipment in appropriate static-safe packaging.
3 Description and Requirements

3.1 Description

The MPI devices netLINK NL 50-MPI and netTAP NT 50-MPI make it possible to communicate via Ethernet to a PROFIBUS MPI automation system.

1. The gateway devices can be used together with the IBHnet driver as a programming adapter with PROFIBUS MPI for a Simatic S7 or a S7 compatible PLC.
2. The gateway devices make it also possible to communicate via Ethernet to PROFIBUS MPI.

The Configuration (set IP-Address, PROFIBUS parameter etc.) is carried out via the Ethernet. For this purpose either

- the configuration software SyConMPI or alternatively
- the IBHnet driver

can be used.

The configuration is saved in the device in a FLASH memory.

Both gateway devices have the same compatible interface regarding communication and configuration. The devices support the PROFIBUS MPI protocol (as a client) at the D-Sub connector and are a complete gateway together with the 10/100 MBit/s Ethernet interface, which detects by auto detection the Ethernet transmission rate of 10 or 100 MBit/s.

3.1.1 Description netLINK NL 50-MPI

The netLINK NL 50-MPI device described in this user manual is an Ethernet Gateway based on netX technology. This device is a successor of the netLINK NL-MPI device.

Because of its structure in the D-Sub housing, it can be plugged directly on to the fieldbus connection of a PROFIBUS MPI capable device and connects this, using an external Ethernet cable to the next Ethernet switch.

The netLINK NL 50-MPI device has a standard RJ45 ethernet socket to connect an Ethernet cable.

The power supply is provided directly by the MPI Interface or externally.

3.1.2 Compatibility of the netLINK NL 50-MPI to the NL-MPI

The netLINK NL 50-MPI device is compatible to the netLINK NL-MPI with respect to the following details:

- The communication functionality for user data exchange is compatible,
- the configurations of both device are compatible.

With respect to the diagnostic functions there is only a partial compatibility.
3.1.3 Description netTAP NT 50-MPI

The netTAP NT 50-MPI device described in this user manual is an Ethernet Gateway based on netX technology. This device is a successor of the netTAP NT 40-MPI device.

The device is for top-hat rail mounting and thus suitable for permanent installation within a PROFIBUS automation system.

The power supply is provided via a mini Combicon connector. The energy supply is galvanically separated from the data lines of the PROFIBUS and the Ethernet.

3.1.4 Compatibility of the netTAP NT 50-MPI to the NT 40-MPI

The netTAP NT 50-MPI device is compatible to the netTAP NT 40-MPI with respect to the following details:

- The communication functionality for user data exchange is compatible,
- the configurations of both device are compatible.

With respect to the diagnostic functions there is only a partial compatibility. The netTAP NT 50-MPI device contains functionality (plus additional) of the netTAP NT 40-MPI. Hence, the netTAP NT 50-MPI can be used as a replacement for the netTAP NT 40-MPI device.

3.2 System Requirements

For a reasonable application of the devices, a suitable supply voltage is required. The supply voltage to be applied must be in the range between 18 V and 30 V.

netLINK NL 50-MPI

The supply voltage for the netLINK NL 50-MPI device can be done either via the PROFIBUS interface X11 (from the S7 PLC) or externally via the mini Combicon connector X1.

netLINK NT 50-MPI

The supply voltage for the netTAP NT 50-MPI device is only possible via the mini Combicon connector X1.
3.3 Preconditions for Operation

The following preconditions must be met in order to operate the MPI device successfully:

1. A suitable power supply as described above is required.

   **CAUTION!**
   - The reference potential of the supply voltage is galvanically connected with the reference potential of the PROFIBUS for hardware revision 2 and 3 of the device. From this it follows that the power supply must be potential free!

   **NOTICE**
   - The reference potential of the supply voltage is galvanically connected with the reference potential of the PROFIBUS for hardware revision 2 and 3 of the device. From this it follows that the power supply must be potential free!

   With hardware revision 4 of the NL 50-MPI device the supply voltage of the device and the PROFIBUS interface is connected via optocoupler and hence galvanically separated.

   **Device Destruction!**
   - The reference potential of the supply voltage is galvanically connected with the reference potential of the PROFIBUS for hardware revision 2 and 3 of the device. From this it follows that the power supply must be potential free!

   For netLINK NL 50-MPI

   For netTAP NT 50-MPI

   Via mini Combicon connector X1. The supply voltage is galvanically separated to the data lines.

2. The device must have been configured correctly.
   The configuration is possible with the IBHNet driver within STEP7® or with the included system configurator SyConMPI.

   The necessary system requirements for the application of the system configurator SyConMPI are:
   - PC with Pentium® processor or higher
   - Windows® XP SP3, Windows® Vista (32-Bit) SP2, Windows® 7 (32-Bit) SP1 or Windows® 7 (64-Bit) SP1
   - Free space on hard disk: 30-80 MByte
   - DVD ROM drive
   - RAM: min. 256 MByte
   - Graphic resolution: min. 800 x 600 pixel, recommended 1024 x 768
   - Keyboard and mouse
4 Device Drawing and Connections

4.1 Device and Dimensioned Drawing

<table>
<thead>
<tr>
<th>netLINK NL 50-MPI</th>
<th>netTAP NT 50-MPI</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Dimensioned Drawing NL 50-MPI and NT 50-MPI" /></td>
<td></td>
</tr>
</tbody>
</table>

*Figure 1: Dimensioned Drawing NL 50-MPI and NT 50-MPI (Size in mm)*
4.2 Connections and LEDs

<table>
<thead>
<tr>
<th>Item</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>Connector for the supply voltage.</td>
</tr>
<tr>
<td>X2</td>
<td>PROFIBUS interface, 9 pin D-Sub female connector.</td>
</tr>
<tr>
<td>X3</td>
<td>Ethernet interface, RJ45 socket.</td>
</tr>
<tr>
<td>X11</td>
<td>PROFIBUS interface, 9 pin male connector (only for NL 50-MPI, 1:1 connection with X2).</td>
</tr>
<tr>
<td>①</td>
<td>SYS-LED.</td>
</tr>
<tr>
<td>②</td>
<td>COM-LED at netLINK NL 50-MPI. APL-LED at netTAP NT 50-MPI.</td>
</tr>
<tr>
<td>③</td>
<td>LED, yellow, ACT (activity) at X3.</td>
</tr>
<tr>
<td>④</td>
<td>LED, green LINK at X3.</td>
</tr>
<tr>
<td>⑤</td>
<td>PROFIBUS station address *1 (only at NT 50-MPI). Station address 00 … 98: The station address set at the rotary switch is used.</td>
</tr>
<tr>
<td>⑥</td>
<td>PROFIBUS station address *10 (only at NT 50-MPI) Station address 99: The station address as configured by the configuration software is used.</td>
</tr>
</tbody>
</table>

Figure 2: Connections and LEDs NL 50-MPI and NT 50-MPI
4.3 Ethernet Interface (X3)

For the Ethernet interface use RJ45 plugs and twisted pair cable of category 5 (CAT5) or higher, which consists of 4 twisted cores and has a maximum transmission rate of 100 MBit/s (CAT5).

4.3.1 Ethernet pinning at the RJ45 Socket

Note: The device supports the Auto Crossover function. Due to this fact RX and TX can be switched. The following figure shows the RJ45 standard pinning.

<table>
<thead>
<tr>
<th>Ethernet</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TX+</td>
<td>Transmit data positive</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>TX–</td>
<td>Transmit data negative</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>RX+</td>
<td>Receive data positive</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Term 1</td>
<td>Connected and terminated to PE via RC combination*</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Term 1</td>
<td>Connected and terminated to PE via RC combination*</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>RX–</td>
<td>Receive data negative</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Term 2</td>
<td>Connected and terminated to PE via RC combination*</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Term 2</td>
<td>Connected and terminated to PE via RC combination*</td>
<td></td>
</tr>
</tbody>
</table>

Table 11: Ethernet RJ45 Pin Assignment

4.3.2 Ethernet Connection Data

<table>
<thead>
<tr>
<th>Medium</th>
<th>2 x 2 Twisted-Pair copper cable, CAT5 (100 MBit/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length of cable</td>
<td>max. 100 m</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>10 MBit/s / 100 MBit/s</td>
</tr>
</tbody>
</table>

Table 12: Ethernet Connection Data
4.4 PROFIBUS Interface (X11, X2)

**netLINK NL 50-MPI**
- D-Sub plug X11 (male connector) to connect to the S7 PLC (or another MPI capable device).
- D-Sub socket X2 (female connector) to connect a programming device.
  - X11 and X2 have internally a 1 to 1 connection.

**ntTAP NT 50-MPI**
- D-Sub connector X2 to connect a PROFIBUS network cable.
  - Use a cable with terminating resistors at the beginning and the end of the cable.

**Figure 3: PROFIBUS Interface X11 (D-Sub male connector, 9 pin)**

<table>
<thead>
<tr>
<th>Pin D-Sub male / female connector</th>
<th>Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X 1</td>
<td>-</td>
<td>unused, is only connected through</td>
</tr>
<tr>
<td>X 2</td>
<td>DGND</td>
<td>Reference potential (for hardware revision 2 and 3)</td>
</tr>
<tr>
<td></td>
<td>GND</td>
<td>Ground (for VS) (for hardware revision 4)</td>
</tr>
<tr>
<td>X X 3</td>
<td>RxD/TxD-P</td>
<td>Receive/send data positive respectively connection B</td>
</tr>
<tr>
<td>X X 4</td>
<td>-</td>
<td>unused, is only connected through</td>
</tr>
<tr>
<td>X X 5</td>
<td>DGND</td>
<td>Reference potential (for hardware revision 2 and 3)</td>
</tr>
<tr>
<td></td>
<td>ISOGND</td>
<td>Reference potential (PROFIBUS) (for hardware revision 4)</td>
</tr>
<tr>
<td>X X 6</td>
<td>-</td>
<td>unused, is only connected through</td>
</tr>
<tr>
<td>X 7</td>
<td>VS</td>
<td>Positive power supply (24 V)</td>
</tr>
<tr>
<td>X X 8</td>
<td>RxD/TxD-N</td>
<td>Receive/send data negative respectively connection A</td>
</tr>
<tr>
<td>X 9</td>
<td>-</td>
<td>unused, is only connected through</td>
</tr>
<tr>
<td>Housing shield</td>
<td>shield</td>
<td>shield</td>
</tr>
</tbody>
</table>

**Table 13: PROFIBUS Interface (D-Sub female and male connector, 9 pin)**

**netTAP NT 50-MPI**: Only D-Sub female connector X2 is available and pins 1, 2, 7 and 9 are not used.
4.5 External Power Supply (X1)

netLINK NL 50-MPI
The netLINK NL 50-MPI device can be supplied with DC external power supply of 24 V (18 V – 30 V).

**Device Destruction at netLINK NL 50-MPI!**
- When using an external supply voltage, the potential of this supply voltage is DC coupled to that of the PROFIBUS. Consequently, the power supply must be potential free!

**WARNING**
- Device Destruction at netLINK NL 50-MPI!

Plug the supply voltage DC into the power jack located at the top side of the device.

netTAP NT 50-MPI
The netTAP NT 50-MPI device has to be supplied with DC external power supply of 24 V (18 V – 30 V) at connector X1.

netLINK NL 50-MPI and netTAP NT 50-MPI

**Supply Voltage Pin Assignment**

<table>
<thead>
<tr>
<th>Supply Voltage</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mini Combicon</td>
<td>1</td>
<td>0 V / GND</td>
<td>Ground of supply voltage</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>24 V</td>
<td>+24 V supply voltage</td>
</tr>
</tbody>
</table>

*Table 14: Supply Voltage Pin Assignment*
4.6 Schematic Diagram - Galvanic Isolation

4.6.1 netLINK NL 50-MPI

For the netLINK NL 50-MPI device the connection to PE takes place via the metal connection (shielding of the cable).

<table>
<thead>
<tr>
<th>Area</th>
<th>Connection</th>
<th>Interface</th>
<th>galv. isolation</th>
<th>Coupling</th>
<th>Coupling against PE</th>
<th>Functional earthing to PE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>X1</td>
<td>-</td>
<td>no</td>
<td>HF</td>
<td>Lf = 47 μH</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cx1</td>
<td>1 * 1 nF / 1000 V</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1 * 22 pF / 63 V</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>X2</td>
<td>PROFIBUS</td>
<td>inductive</td>
<td>Cx2</td>
<td>1 MΩ // 2,2 nF / 500 V</td>
<td>directly via the metal connection of the D-Sub male connector</td>
</tr>
<tr>
<td>3</td>
<td>X3</td>
<td>Ethernet</td>
<td>inductive</td>
<td>Cx3</td>
<td>4 * 75 Ω, 1 nF / 2000 V</td>
<td>directly via the metal housing of the RJ 45 connector</td>
</tr>
</tbody>
</table>

Table 15: Coupling NL 50-MPI, Hardware Revision 4

Figure 5: netLINK NL 50-MPI, Coupling (Hardware Revision 4)
4.6.2 netTAP NT 50-MPI

The connection to PE takes place for the netTAP NT 50-MPI via the top-hat rail.

<table>
<thead>
<tr>
<th>Area</th>
<th>Connection</th>
<th>Interface</th>
<th>galv. Isolation</th>
<th>Coupling</th>
<th>Coupling against PE</th>
<th>Functional earthing to PE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>X1</td>
<td>-</td>
<td>no</td>
<td>HF</td>
<td>Cf = 10 nF / 500 V, Lf = 47 μH</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cx1</td>
<td>4 * 10 nF / 500 V</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>X2</td>
<td>PROFIBUS</td>
<td>inductive</td>
<td>Cx2</td>
<td>1 MΩ // 2.2 nF / 1000 V</td>
<td>directly via the metal connection of the D-Sub male connector</td>
</tr>
<tr>
<td>3</td>
<td>X3</td>
<td>Ethernet</td>
<td>inductive</td>
<td>Cx3</td>
<td>6 * 75 Ω, 1 nF / 2000 V</td>
<td>directly via the metal housing of the RJ 45 connector</td>
</tr>
</tbody>
</table>

Table 16: Coupling NT 50-MPI
5  Mounting and dismounting the Device

5.1  Mounting netLINK NL 50-MPI

Figure 7: Mounting the netLINK

The NL 50-MPI is slipped ① and screwed ② on a S7 MPI / PROFIBUS interface or another compatible device with the MPI / PROFIBUS interface of the NL 50-MPI.

5.2  Mounting and Dismounting netTAP NT 50-MPI

The devices can be mounted side-by-side without any gap. On the top side, the devices should have a minimum distance of 20 mm to the next device. The air ventilation slots of the device must not be covered by any objects.

5.2.1  Top Hat Rail Mounting of the NT 50-MPI

Mount the top hat rail according to DIN EN 60715 for the netTAP device horizontally at the intended location. The DIN top hat rail has to be connected with the potential equalization conductor (PE).

Figure 8: Mounting the netTAP NT 50 device onto the top-hat rail

Push the device onto the top hat rail from above ①. Then press the device against the mounting surface, according to arrow ②.

Afterwards connect the 24 V supply voltage to the device. Grounding is done via a grounding contact located at the backside of the device connecting it electrically to the top-hat rail.
5.2.2 Removing the NT 50 from the Top-Hat Rail

In order to remove the netTAP from the top-hat rail, first remove the power supply cable and all data cables from the device.

To release the device from the top-hat rail, use a screw driver, which you put at the clip ① in the center of the device. By pressing slightly the screw driver in direction of arrow ② the lock at the top-hat rail is released. You can then easily pull the device off the top-hat rail in direction of arrow ③.

*Figure 9: Removing the NT 50 device from the Top-Hat Rail*
5.3 Power Supply

5.3.1 netLINK NL 50-MPI

The power supply of the NL 50-MPI device can be done directly by plugging the device onto a PLC, if pin 7 of the D-Sub connector of the PLC provides 24 V DC. Alternatively it is possible to connect the supply voltage of 24 V DC externally using the Mini-Combicon connector.

---

**Device Destruction!**

- The reference potential of the supply voltage is galvanically connected with the reference potential of the PROFIBUS interface for hardware revision 2 and 3 of the device. From this it follows that the power supply must be potential free!

---

**NOTICE**

- The reference potential of the supply voltage is galvanically connected with the reference potential of the PROFIBUS interface for hardware revision 2 and 3 of the device. From this it follows that the power supply must be potential free!

With hardware revision 4 of the NL 50-MPI device the supply voltage and the PROFIBUS interface is galvanically separated by opto coupler.

5.3.2 netTAP NT 50-MPI

The supply voltage for the netTAP NT 50-MPI of 24 V DC is only possible via the mini Combicon connector X1. The supply voltage is galvanically separated from the data lines of the PROFIBUS and the Ethernet interface.

5.4 Ethernet Connection

The Ethernet connector of the NL 50-MPI is connected by an Ethernet cable to a switch, hub or Ethernet end device.

The NL 50-MPI operates its Ethernet interface in the Auto-crossover mode. Thus for the connection with Ethernet devices both crossover cables and patch cables are applicable.
6 Installing Software

6.1 Installing Software from DVD

To install the software:
- Close all application programs on the system!
- Insert the DVD in the local DVD ROM drive.
- The installation routine will start automatically (Auto start feature enabled). Otherwise change to the root directory of the DVD and start the EXE file (Auto start feature disabled).

**Note:** Administrator privileges are required on Windows® 2000/Windows® XP/Windows® Vista/Windows® 7 systems for installation!

![Menu of the DVD Autostart](image)

The menu offers the following for installation:
- **Install STEP 7® Driver IBHNet**
  This allows to use the STEP7® software or "STEP7 for Windows" software to program or to configure a S7 or S7 compatible PLC via a NL 50-MPI device or a NT 50-MPI device.
- **Install SyCon configuration software** (the Hilscher IP Driver can be installed during the installation of SyCon).
  This allows to configure the NL 50-MPI device or the NT 50-MPI device independent of the STEP® software. Read and write commands via Ethernet can be performed via PROFIBUS MPI to the automation system.
- **Open Documentations Directory**
To configure the MPI device you can use either the IBHnet driver or SyConMPI.
For the system configurator SyConMPI no license is required as the basic version already contains all functions necessary for the configuration of the devices.

6.2 Installation under Windows Vista or Windows 7

The program WinHlp32.exe is not included in the operating system Windows Vista and Windows 7. It is necessary to display the online help files (*.HLP format). For download and installation information follow this link:
http://support.microsoft.com/kb/917607

6.3 Install IP Driver

Some application programs use the Hilscher IP Driver to communicate with the MPI device.
The installation program for the Hilscher IP driver is on the DVD in the TcpUdpIpDriver folder.
➢ Start on the DVD in the folder TcpUdpIpDriver the setup.exe.

➢ At the first screen, you simply have to click Next in order to proceed.
➢ Then some information about the IP driver is displayed on the screen. You should read this text carefully.
At the next screen, you are asked to specify the storage location for the Hilscher IP Driver.

![Install IP Driver (2)](image1)

Figure 12: Install IP Driver (2)

You may choose the proposed standard location or choose another one after clicking **Browse**. Then click **Next** again in order to proceed.

After that, you will reach the final screen indicating that the installation process has been completed.

![Install IP Driver (3)](image2)

Figure 13: Install IP Driver (3)

- Click **Finish**.

After the installation the driver has to be configured correctly, i.e. the IP address and the port number of the MPI device need to be specified as described in the next section of this document.
7 Configuring MPI Device

7.1 Configuring MPI-Device with Hilscher IP Driver

7.1.1 Assign IP Address to MPI Device

Assign an IP address to the device. Proceed as follows:

Start the Program **NetIdentDemo**

- Select **Start > Programs > Hilscher IP Driver > NetIdentDemo Program**

![Figure 14: NetIdent Demo](image)

- Click **Start**.

The window for IP address assignment opens.

![Figure 15: netIdent – Scan for Devices (1)](image)

- After you have provided supply voltage to the MPI device and connected via an Ethernet cable to the PC, click **Start Poll** to start the scan.

The scan for devices is done at all Ethernet interfaces on the PC. Found devices are displayed.
Select the MPI device that should be configured. Afterwards, click **Set IP**.

The pop-up windows above opens.

Enter the IP address for the MPI device. Afterwards, click **Set IP**.

If the IP address was set successfully, then the following window appears:

Click **OK**.
Click **Exit**.

Note: The IP address set is only valid (temporarily) as long as the device is not disconnected from power supply. To set a permanent IP address see section *Creating and downloading the Configuration to set a permanent IP Address* on page 36.
7.1.2 Configuring of the IP Driver

- Start the configuration program of the Hilscher IP Driver with **Start > Programs > Hilscher IP Driver > IP Driver Setup**.

  - The GUI of the Hilscher IP Driver Setup program will appear then:

![GUI of the Hilscher IP Driver Setup](image)

- Enter the configured IP address of the MPI device in the field **IP Address** and the Port number in the field **Port**.

- The following settings are necessary:

<table>
<thead>
<tr>
<th>Field</th>
<th>Required action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Port</strong></td>
<td>Set the port to 1099.</td>
</tr>
<tr>
<td><strong>Protocol</strong></td>
<td>Set the protocol to TCP.</td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td>Set the mode to Client.</td>
</tr>
</tbody>
</table>

*Table 17: Configuring IP Driver*

- **Connect Timeout (ms)**: In client mode this field holds the time period the driver tries to establish a connection with the selected MPI device.

  - **Note**: A time out value that is too small can prevent correct connection establishment to the MPI device.

  - **Note**: If this setting shall be changed later again, the program **IpDrvSetup.exe** and also the programs which use the driver need to be restarted.

  - **Note**: If the PC is behind a Firewall, then port 1099 has to be unblocked. For this, contact your network administrator.

- Click **OK** to close the dialog.
7.2 Creating and downloading the Configuration to set a permanent IP Address

7.2.1 Overview

**Note:** The configuration of the MPI device is done via TCP/IP.

To create and to download the configuration of the MPI device, proceed as follows:

1. Start the system configurator SyCon:
   - Select **Start > Programs > SyCon System Configurator > SyCon**.

2. Create a new project:
   - Select menu **File > New** or **File > New > MPI**.

3. Insert the MPI device to the project:
   - Select menu **Insert > Device**.
   - In the window **Insert Device** under **Available devices** select the MPI device **NL 50-MPI** or **NT 50-MPI**.
   - Click **Add**.
   - Click **OK**.

4. Setting the IP address and the PROFIBUS parameters:
   - Select menu **Settings > MPI Parameter** or double click the MPI device symbol.
   - The parameter window is displayed.
   - Set the IP address, if necessary also the Net Mask and the gateway address.
   - A description of these parameters is included in the section **IP Address** on page 47.

   - Set the PROFIBUS parameters, especially the station address and the bus parameters.
   - A description of the PROFIBUS parameters are in the section **PROFIBUS Parameter** on page 49.
5. Connecting the System configurator SyCon with the MPI device:
   - Select menu **Settings > Device Assignment**.
   - Select in the window **Driver Select** the driver **CIF TCP/IP Driver**.
   - Click **OK**.
   - The window **Device Assignment ODM TCP/IP Drive** is displayed.
   - Click **netIdent Rescan**.
   - The local Ethernet network is scanned for MPI devices. Found devices are displayed under **Board Selection**.
   - In the list **Board Selection** mark the check box for the MPI device.
   - A connection from the System configurator SyCon to the MPI device has been established.
   - Click **OK**.
   - The window **Device Assignment ODM TCP/IP Drive** is closed.

6. Downloading the configuration to the device:
   - Select menu **Online > Download**.
   - The safety question is displayed, if the download should be executed.
   - Click **Yes**.
   - The configuration is downloaded to the device.

7. Reset the device to activate the new configuration:
   - Select menu **Online > Firmware/Reset**.
   - The window **Firmware/Reset** is displayed.
   - Click **Reset**.
   - The safety question is displayed, if the reset shall be executed.
   - Select the button **Yes**.
   - The reset is executed. By this the configuration is activated.

8. Saving the SyCon project:
   - Select menu **File > Save under**.
   - The window **Save under** is displayed.
   - Enter the file name for the project.
   - Click **OK**.
   - The project is saved.
### 7.2.2 Step-by-Step Description

**Step 1:** Start the system configurator SyConMPI
- Select `Start > Programs > SyCon System Configurator > SyCon`.

**Step 2:** Create a new project
- Select `File > New` or `File > New > MPI`.
- An empty project file (configuration file) is created and is displayed.

![Figure 22: System Configurator SyConMPI – Create a new Project](image)

**Step 3:** Insert the MPI device to the project
- Select menu `Insert > Device`.
- The window `Insert Device` is displayed.

![Figure 23: Insert Device](image)

- Under **Available devices** select the device **NL 50-MPI**.
- Click **Add**.
- Click **OK**.
- The MPI device is displayed in the SyCon project or the configuration file.
Figure 24: System Configurator SyConMPI – The MPI Device is displayed in the Project

**Step 4:** Set IP address and PROFIBUS parameters
- Select menu Settings > MPI Device Parameter or double click to the MPI device symbol.
- The parameter window is displayed.

![MPI Device Parameter Window]

**Step 4A:**
- Set the IP address, if necessary also the Net Mask and the gateway address.

A description of these parameters is included in the section *IP Address* on page 47.
**Step 4B:**
- The Ethernet parameters are detected automatically by the device.
- A description of the Ethernet parameters is in the section *Ethernet Parameter* on page 48.

![Ethernet Parameters](image)

*Figure 26: Ethernet Parameters are detected automatically by the MPI Device*

**Step 4C:**
- Set the PROFIBUS parameters.

![PROFIBUS Parameters](image)

*Figure 27: Set the PROFIBUS Parameters*

- Set the PROFIBUS parameters (especially the station address 1, the bus profile 2 and the bus parameters).
- A description of the PROFIBUS parameters is in the section *PROFIBUS Parameter* on page 49.
- Click **OK** 3.
- The parameter window is closed.
**Step 5:** Connecting the system configurator SyConMPI to the MPI device
A.) Select the driver **CIF TCP/IP Driver**.
B.) Scan for MPI devices.
C.) If necessary, change and assign the IP address manually.
D.) Connect the system configurator SyConMPI with the MPI device.

Proceed as follows:

**Step 5A:** Select the driver **CIF TCP/IP Driver**

- Select menu **Settings > Device Assignment**.

![Figure 28: Window Driver Select](image)

- The **Driver Select** window is displayed.

![Figure 29: Window Driver Select](image)

- Select in the window **Driver Select** the driver **CIF TCP/IP Driver** ①.
- Click **OK** ②.
- The window **Device Assignment ODM TCP/IP Drive** is displayed.
**Step 5B:** Scan for MPI devices  
- In the window **Device Assignment ODM TCP/IP Driver** click **netIdent Rescan**.  
- The local Ethernet network is scanned for devices. The detected devices are displayed under **Board Selection**.

**Step 5C:** If necessary, change and assign the IP address manually.  
- If one or more devices were found, they are displayed in the list **Board Selection** with their MAC-ID. If the device already has an IP address this is shown in the column **IP Address**.

**Step 5C:** If necessary, change and assign the IP address manually.  
- If the shown IP address is 0.0.0.0 or the IP address shall be changed, an IP address has to be assigned to the device.  
- In the window **Device Assignment ODM TCP/IP Driver** in the list **Board Selection** mark the check box for MPI device.
- Select the button **Set IP Address**.
- The window **Configure IP Address** is displayed.

![Configure IP Address](image1)

**Figure 32: Window Configure IP Address**

- Enter a valid IP address.

![Configure IP Address](image2)

**Figure 33: Window Configure IP Address – Set the IP address**

- Click **Set IP**.

**Note:** With **Set IP** only a temporarily IP address is set in the MPI device. To set a permanent IP address a configuration download has to be done.

**Note:** When the IP address set in this step 5C and the IP address entered in step 4A are different, then the IP address of step 4A is used from the device after a download of the configuration and a reset.

- The IP address is assigned to the device.
- The hint window **Setting IP address successful!** is displayed.

![Hint](image3)

**Figure 34: Hint – Setting IP Address successful**

- Click **OK**.
- In the window **Configure IP Address** click **Exit**.
- The window **Configure IP Address** is closed.
Step 5D: Connect the system configurator SyConMPI with the MPI device:

In the window **Device Assignment ODM TCP/IP Drive** in the list **Board Selection** mark the check box \(\checkmark\) for MPI device.

A connection from the System configurator SyCon to the MPI device has been established.

Click **OK** \(\textcircled{2}\).

The window **Device Assignment ODM TCP/IP Drive** is closed.
**Step 6:** Download the configuration to the device

- Select in the system configurator **SyCon** the menu **Online > Download**.

  ![SyCon - [Unnamed1]](image)

  *Figure 36: Online Configuration Download*

  - The safety question is displayed, if the download should be executed.

  ![Question](image)

  *Figure 37: Question – Do you really want to download?*

  If the download must not be executed:
  - Click **No**.
  - The download is not executed.

  If the download must be executed:
  - Click **Yes**.
  - The download is executed. During the download the progress bar **Data Base Download** is displayed.

  ![Data Base Download](image)

  *Figure 38: Progress Bar Data Base Download*

  - The configuration is downloaded to the MPI device.
Step 7: Reset the device to activate the new configuration
- Select in the system configurator SyConMPI menu Online > Firmware/Reset.
- The window Firmware/Reset is displayed.

![Figure 39: Window Firmware/Reset](image)

- Click Reset.
- The window is displayed, if the reset shall be executed.

![Figure 40: Question – Do you really want to reset the firmware?](image)

- Click Yes.
- The reset is executed and the new configuration is activated.

Step 8: Saving the project
- Select menu File > Save under.
- The window Save under is displayed.
- Enter the file name for the project.
- Select OK.
- The project is saved.
7.3 Description of the Device Parameters

7.3.1 IP Address

Figure 41: Settings > MPI Device Parameter > IP Address

Description ①:
The description of the device is shown in SyConMPI as the name of the device. The description is changeable in this field.
The handing over of the IP parameters which are the IP address, Net mask, and Gateway can result in three ways.

1. DHCP ②:
The device gets the IP parameters from a DHCP server.

2. BOOTP ③:
The device gets the IP parameters from a BOOTP server.

3. IP address, Net mask and Gateway ④:
The IP parameters can be entered in this fields. If more than one configuration way is activated (for example DHCP and manually entered IP parameters), the MPI device tries to process the different configuration ways one after the other. As soon as it got the IP parameters by one of these ways, the MPI device starts with these parameters.
7.3.2 Ethernet Parameter

![Figure 42: Settings > NetLink Parameter > Ethernet](image)

**Description**: The description of the device is shown in SyCon as the name of the device. The description is changeable in this field.

**Auto detect**: This option is set. An automatic detection of the Ethernet interface is done by the MPI device.

**Interface**: Is detected automatically.

**Auto negotiation**: Auto negotiation means, that in case of two connected devices the devices detect the hardware and the features (for example Half- or Full Duplex, 10 or 100 Mbits and so on) of the other device. This option is preselected.

**Duplex mode**: Duplex mode of the Ethernet interface. Is detected automatically.

**Speed**: Transmission speed of the data in MBits/s: 10 MBits/s and 100 MBits/s. Is detected automatically.
7.3.3 PROFIBUS Parameter

Note: Wrong configured PROFIBUS Parameters can lead to communication failures.

The busparameters and their meaning:

- **Station Address**
  The Station Address of the MPI device. The bus address set at the rotary switch is valid for netTAP NT 50-MPI device as long as the bus address set at the rotary switch is unequal to 99. For the position of the rotary switches see section Connections and LEDs on page 20.

- **Bus profile**
  Allows the selection of MPI or PROFIBUS

- **Baudrate**
  Transmission speed: Number of bits per second.

<table>
<thead>
<tr>
<th>Baudrate</th>
<th>Bit Time (t_{\text{ba}})</th>
</tr>
</thead>
<tbody>
<tr>
<td>9,6 kBaud</td>
<td>104,2 µs</td>
</tr>
<tr>
<td>19,2 kBaud</td>
<td>52,1 µs</td>
</tr>
<tr>
<td>93,75 kBaud</td>
<td>10,7 µs</td>
</tr>
<tr>
<td>187,5 kBaud</td>
<td>5,3 µs</td>
</tr>
<tr>
<td>500 kBaud</td>
<td>2 µs</td>
</tr>
<tr>
<td>1,5 Mbaud</td>
<td>666,7 ns</td>
</tr>
<tr>
<td>3 Mbaud</td>
<td>333,3 ns</td>
</tr>
<tr>
<td>6 Mbaud</td>
<td>166,7 ns</td>
</tr>
<tr>
<td>12 Mbaud</td>
<td>83,3 ns</td>
</tr>
</tbody>
</table>

*Table 18: Baud rates and Bit times*
• **Slot Time** (T<sub>SL</sub>)<sup>4</sup>
  'Wait for receipt' – monitoring time of the Senders (Requestor) of telegram for the acknowledgement of the recipient (Responder). After expiration, a retry occurs in accordance with the value of 'Max. telegram retries'.
  Value range: 52 ... 65535

• **Minimum Station Delay of Responders** (min T<sub>SDR</sub>)<sup>5</sup>
  This is the shortest time period that must elapse before a remote recipient (Responder) may send an acknowledgement of a received query telegram. The shortest time period between receipt of the last Bit of a telegram to the sending of the first Bit of a following telegram.
  Value range: 1 ... 65535

• **Maximum Station Delay of Responders** (max T<sub>SDR</sub>)<sup>6</sup>
  This is the longest time period that must elapse before a Sender (Requestor) may send a further query telegram. Greatest time period between receipt of the last Bit of a telegram to the sending of the first Bit of a following telegram.
  The Sender (Requestor, Master) must wait at least for this time period after the sending of an unacknowledged telegram (e.g. Broadcast only) before a new telegram is sent.
  Value range: 1 ... 65535

• **Quiet Time** (T<sub>QUI</sub>)<sup>7</sup>
  This is the time delay that occurs for modulators (Modulator-trip time) and Repeaters (Repeater-switch time) for the change over from sending to receiving.
  Value range: 0 ... 255

• **Setup Time** (T<sub>SET</sub>)<sup>8</sup>
  Minimum period “reaction time” between the receipt of an acknowledgement to the sending of a new query telegram (Reaction) by the Sender (Requestor).
  Value range: 1 ... 255

• **Target Rotation Time** (T<sub>TR</sub>)<sup>9</sup>
  Pre-set nominal Token cycling time within the Sender authorization (Token) will cycle around the ring. How much time the Master still has available for sending data telegrams to the Slaves is dependent on the difference between the nominal and the actual token cycling time.
  Value range: 1 ... 16.777.215

• **GAP Update Factor** (G)<sup>10</sup>
  Factor for determining after how many Token cycles an added participant is accepted into the Token ring. After expiry of the time period G*T<sub>TR</sub>, the Station searches to see whether a further participant wishes to be accepted into the logical ring.
  Value range: 1 ... 100

• **Max number of telegram retries** (Max_Retry_Limit)<sup>11</sup>
  Maximum number of repeats in order to reach a Station.
  Value range: 1 ... 8
• **Highest Station Address (HSA)**

Station address of the highest active (Master) Station.

Value range: 2 ... 126

The device MPI devices support the automatic baudrate detection.

![Image showing MPI Parameters settings]

To set the automatic baudrate detection, select in the list of **Bus profile** the setting **PROFIBUS** and then select in the list **Baud rate** the setting **AutoBaud**.

**Note:** The automatic detection of the PROFIBUS baudrate can only be used, when additionally to the netLINK NL 50-MPI respectively netTAP NT 50-MPI another PROFIBUS Master is available on the PROFIBUS network.

**Note:** The automatic detection of the PROFIBUS baudrate can only be used, when the control unit sends the PROFIBUS parameters via a broadcast telegram on the PROFIBUS network.

**Note:** A download of the configuration has to be done to activate these setting in the MPI device.

**Note:** In order that the new settings become active after the download reset is required for the MPI device.
7.4 Firmware Update – Firmware Download

The section describes how to do a firmware update.

**Step A:**
- Start the System Configurator SyCon with **Start > Programs > SyCon**
- System Configurator > SyCon

**Step B:**
- Open an existing project/configuration file with menu **File > Open**. The extension is \*.nd.
- Create a configuration as it is described in steps 2, 3 and 4 in section *Creating and downloading the Configuration to set a permanent IP Adress on page 36.*

**Step C:**
- With menu **Settings > Device Assignment** create a connection to the MPI device. This is described in detail in step 5 in section *Creating and downloading the Configuration to set a permanent IP Adress on page 36.*

**Step D:**
- Select menu **Online > Firmware Download**.
- A safety question is displayed.

Figure 45: Question – Do you really want to download?

If the download must not be executed:
- Click **No**.
- The download is not executed.

If the download must be executed:
- Click **Yes**.
- The window **Firmware Copy/Download** is displayed.
Select in **Available Firmware Files** section the directory that contains the firmware file, e.g. on the DVD. The firmware filename is `nl50mpi.e50`. The file can be used for the netLINK NL 50-MPI and netTAP NT 50-MPI device.

- Press the button **Download** in **Available Firmware Files** section.  
  - A safety question is displayed.

If the download must not be executed:

- Click **No**.  
  - The download is not executed.
If the download must be executed:

- Click **Yes**.
- The download is executed. During the download the progress bar **Data Base Download** is displayed.

*Figure 48: Progress Bar Data Base Download*

- After the firmware download was finished, in the window **Firmware Copy/Download** click **Close**.

**Step E:**

- Load with menu **Online > Download** the configuration into the MPI device. This is describes in step 6 in section *Creating and downloading the Configuration to set a permanent IP Adress* from page 36.

**Step F:**

- The device uses the new firmware or the new configuration/new parameters after a reset. This is describes in Step 7 in section *Creating and downloading the Configuration to set a permanent IP Adress* from page 36.
8 Troubleshooting

8.1 Hints on how to solve Problems

**General**
- Check, if the following preconditions for the MPI device operation are fulfilled:
  1. A suitable supply voltage must be available.
  2. The configuration must have been performed correctly using the system configurator SyConMPI.

Further information to this is in section *Preconditions for Operation* on page 18.

**LNK-LED**
- With the Ethernet link status LED (LNK) of the MPI device can be examined whether a connection to the Ethernet exists. If the LED is off, no connection exists. If the LED is on, the device has a connection to the Ethernet.

**ACT-LED**
- With the status LED ACT of the MPI device can be examined whether communication takes place.

**Cable**
- Make sure that the cable is connected to the switch on the Ethernet side and that the serial interface is connected to the S7.

**Configuration**
- Check, whether the MPI device is configured according to the description given in section *Creating and downloading the Configuration to set a permanent IP Adress* on page 36.

**Diagnostic using the System Configurator SyCon**
- Read out the data with menu *Online > Message Monitor*.

You can find more information about the Message Monitor and its functions you find in the operating manual *SyConMPI Ethernet-TCP/IP Interface*.

- Check the network settings of your PC.

With the ping command in MS-DOS Prompt you can easily check if a connection via TCP/IP to the MPI device is possible. Open the MS-DOS Prompt and enter ping 192.168.10.190 (the IP address has to be the same as set in the MPI device) and press the Return key. Could a connection be established then the answer is displayed by the following text Reply from 192.168.10.190...

Otherwise a connection timeout is displayed.
8.2 Ethernet Failure in 10 MBit/s Half Duplex Mode and Workaround

Not affected are netTAP NT 50-MPI devices and netLINK NL 50-MPI with serial number greater than 27927, which means: devices manufactured after December 2010 are not affected.

Affected Hardware

Hardware with the communication controller netX 50, netX 100 or netX 500; netX/Internal PHYs.

When can this Failure occur?
When using standard Ethernet communication with 10 MBit/s half duplex mode, the PHY gets stuck in case of network collisions. Then no further network communication is possible. Only device power cycling allows Ethernet communication again.

This problem can only occur with Ethernet TCP/UDP IP, EtherNet/IP or Modbus TCP protocols when using hubs at 10 MBit/s. The issue described above is not applicable for protocols which use 100 MBit/s or full duplex mode.

Solution / Workaround:

Do not use 10 MBit/s-only hubs. Use either switches or 10/100 MBit/s Dual Speed hubs, to make sure the netX Ethernet ports are connected with 100 MBit/s or in full duplex mode.

This erratum is fixed with all components of the ‘Y’ charge (9 digit charge number shows ‘Y’ at position 5 (nnnnYnnnn)).

Reference

“Summary of 10BT problem on EthernetPHY”,
RenesasElectronics Europe, April 27, 2010
## 9 LED

<table>
<thead>
<tr>
<th>LED</th>
<th>Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Status</td>
<td>SYS</td>
<td>System status</td>
</tr>
<tr>
<td>Communication Status</td>
<td>COM</td>
<td>Communication status</td>
</tr>
<tr>
<td>RJ45</td>
<td>LNK</td>
<td>Link (Ethernet link status)</td>
</tr>
<tr>
<td></td>
<td>ACT</td>
<td>Activity (Ethernet activity status)</td>
</tr>
</tbody>
</table>

**Table 19: Names and Meaning of LED**

<table>
<thead>
<tr>
<th>LED</th>
<th>Display color</th>
<th>Display state</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYS</td>
<td>Duo LED yellow/green</td>
<td>(green)</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(yellow)</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking (yellow/green)</td>
<td>Off</td>
</tr>
</tbody>
</table>

**Table 20: Meaning of LED-Signals**

Numbers ① … ④ refer to Figure 2 on page 20.
## LED-Display Status

<table>
<thead>
<tr>
<th>Display Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>The display is lighted permanently.</td>
</tr>
<tr>
<td>Off</td>
<td>The display is not lighted at all.</td>
</tr>
<tr>
<td>Blinking</td>
<td>The display is switched on and off in phases, At regular blinking with a frequency of 5 Hz: On for a duration of 100 ms followed by Off for a duration of 100 ms.</td>
</tr>
</tbody>
</table>

Table 21: Display Status
## 10 Technical Data

### 10.1 Technical Data of the netLINK NL 50-MPI

<table>
<thead>
<tr>
<th>NL 50-MPI</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication controller</td>
<td>Type</td>
<td>netX 50</td>
</tr>
<tr>
<td>RAM</td>
<td>8 MB SDRAM</td>
<td></td>
</tr>
<tr>
<td>FLASH</td>
<td>4 MB serial Flash, contains boot loader, firmware and configuration</td>
<td></td>
</tr>
<tr>
<td>PROFIBUS-MPI communication</td>
<td>Type</td>
<td>Client</td>
</tr>
<tr>
<td>Data transport</td>
<td>PROFIBUS FDL telegrams</td>
<td></td>
</tr>
<tr>
<td>Number of connections</td>
<td>max. 32 MPI connections at a time</td>
<td></td>
</tr>
<tr>
<td>Access to</td>
<td>Data block, Bit memory, Peripheral data, Counter, Timer, State of OP-Mode</td>
<td></td>
</tr>
<tr>
<td>Ethernet communication</td>
<td>Data transport</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Number of connections</td>
<td>max. 16 TCP connections at a time</td>
<td></td>
</tr>
<tr>
<td>RFC 1006</td>
<td>Supported</td>
<td></td>
</tr>
<tr>
<td>PROFIBUS interface</td>
<td>Transmission rate</td>
<td>9,6 kBit/s to 12 MBit/s</td>
</tr>
<tr>
<td>Interface type</td>
<td>RS-485, non-isolated (for revision 2 und 3 of the device) isolated (for revision 4 of the device)</td>
<td></td>
</tr>
<tr>
<td>Connector</td>
<td>D-Sub plug (9-pin male connector)</td>
<td></td>
</tr>
<tr>
<td>Automatic Baud rate detection</td>
<td>supported</td>
<td></td>
</tr>
<tr>
<td>Ethernet interface</td>
<td>Transmission rate</td>
<td>10/100 MBit/s</td>
</tr>
<tr>
<td>Interface type</td>
<td>10 BASE-T/100 BASE-TX, isolated</td>
<td></td>
</tr>
<tr>
<td>Connector</td>
<td>RJ45 socket</td>
<td></td>
</tr>
<tr>
<td>Auto-Negotiation</td>
<td>supported</td>
<td></td>
</tr>
<tr>
<td>Auto-Crossover</td>
<td>supported</td>
<td></td>
</tr>
<tr>
<td>Interface for programming tool</td>
<td>Connector</td>
<td>D-Sub-socket (9-pin female connector)</td>
</tr>
<tr>
<td>Display</td>
<td>LED Display</td>
<td>SYS System Status, COM Communication status, ACT Ethernet activity status, LINK Ethernet link status</td>
</tr>
</tbody>
</table>

Table 22: Technical Data netLINK NL 50-MPI (Part 1)
<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NL 50-MPI</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Power supply</strong></td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>18 – 30 V DC</td>
</tr>
<tr>
<td>Typical current at 18 V</td>
<td>72 mA</td>
</tr>
<tr>
<td>Typical current at 24 V</td>
<td>57 mA</td>
</tr>
<tr>
<td>Typical current at 30 V</td>
<td>48 mA</td>
</tr>
<tr>
<td>Connector for power supply from PLC</td>
<td>via D-Sub-plug (9-pin male connector)</td>
</tr>
<tr>
<td>Connector for external power supply</td>
<td>Mini-Combicon socket 3,81 mm 2 pin</td>
</tr>
<tr>
<td><strong>Electrical immunity to interference</strong></td>
<td></td>
</tr>
<tr>
<td>Electrostatic discharge (ESD) according to IEC/EN 61000-4-2:1995</td>
<td>10 kV Air discharge method, Criterion A 4 kV Contact discharge method, Criterion B</td>
</tr>
<tr>
<td>Fast transient interferences (Burst), zone B, according to IEC/EN 61000-4-4:1995</td>
<td>2 kV Power supply connectors DC, Criterion B 1 kV Communication and data lines, Criterion A</td>
</tr>
<tr>
<td>Surge voltage, zone B, according to IEC/EN 61000-4-5:1995</td>
<td>1 kV CM, 0,5 kV DM Power supply connectors DC, Criterion B 1 kV CM Communication and data lines, Criterion B</td>
</tr>
<tr>
<td><strong>Environmental conditions</strong></td>
<td></td>
</tr>
<tr>
<td>Temperature range</td>
<td>0 … + 55 °C</td>
</tr>
<tr>
<td>Humidity range</td>
<td>0 … 85 % relative humidity (not condensing)</td>
</tr>
<tr>
<td><strong>Device</strong></td>
<td></td>
</tr>
<tr>
<td>Dimensions (L x W x H)</td>
<td>74,3 x 40,6 x 16,7 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>appr. 40 g</td>
</tr>
<tr>
<td>Mounting / Installation</td>
<td>directly at MPI interface</td>
</tr>
<tr>
<td>Protection Class</td>
<td>IP 20</td>
</tr>
<tr>
<td>RoHS</td>
<td>Yes</td>
</tr>
<tr>
<td>UL</td>
<td>in preparation</td>
</tr>
<tr>
<td><strong>CE Sign</strong></td>
<td></td>
</tr>
<tr>
<td>CE Sign</td>
<td>Yes</td>
</tr>
<tr>
<td>Emission</td>
<td>CISPR 11 Class A</td>
</tr>
<tr>
<td>Immunity</td>
<td>EN 61131-2:2003</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td>SYCON.net or IBHnet driver</td>
</tr>
</tbody>
</table>

*Table 23: Technical Data NL 50-MPI (Part 2)*
### 10.2 Technical Data of the netTAP NT 50-MPI

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication controller</strong></td>
<td>netX 50</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>8 MB SDRAM</td>
</tr>
<tr>
<td>FLASH</td>
<td>4 MB serial Flash, contains boot loader, firmware and configuration</td>
</tr>
<tr>
<td><strong>PROFIBUS-MPI communication</strong></td>
<td>Client</td>
</tr>
<tr>
<td>Data transport</td>
<td>PROFIBUS FDL telegrams</td>
</tr>
<tr>
<td>Number of connections</td>
<td>max. 32 MPI connections at a time</td>
</tr>
<tr>
<td>Access to</td>
<td>Data block, Bit memory, Peripheral data, Counter, Timer, State of OP-Mode</td>
</tr>
<tr>
<td><strong>Ethernet communication</strong></td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Number of connections</td>
<td>Max. 16 TCP connections at a time</td>
</tr>
<tr>
<td>RFC 1006</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>PROFIBUS interface</strong></td>
<td>9,6 kBit/s to 12 MBit/s</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9,6 kBit/s to 12 MBit/s</td>
</tr>
<tr>
<td>Interface type</td>
<td>RS-485, non-isolated</td>
</tr>
<tr>
<td>Connector</td>
<td>D-Sub plug (9-pin male connector)</td>
</tr>
<tr>
<td>Automatic Baud rate detection</td>
<td>supported</td>
</tr>
<tr>
<td><strong>Ethernet interface</strong></td>
<td>10/100 MBit/s</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>10/100 MBit/s</td>
</tr>
<tr>
<td>Interface type</td>
<td>10 BASE-T/100 BASE-TX, isolated</td>
</tr>
<tr>
<td>Connector</td>
<td>RJ45 socket</td>
</tr>
<tr>
<td>Auto-Negotiation</td>
<td>supported</td>
</tr>
<tr>
<td>Auto-Crossover</td>
<td>supported</td>
</tr>
<tr>
<td><strong>Anzeige</strong></td>
<td>SYS Systemstatus</td>
</tr>
<tr>
<td>LED-Anzeige</td>
<td>APL Applikationsstatus</td>
</tr>
<tr>
<td></td>
<td>LINK Link</td>
</tr>
<tr>
<td></td>
<td>ACT Activity</td>
</tr>
</tbody>
</table>

*Table 24: Technical Data NT 50-MPI (Part 1)*
<table>
<thead>
<tr>
<th>NT 50</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply</td>
<td>Voltage</td>
<td>24 V ± 6 V DC</td>
</tr>
<tr>
<td></td>
<td>Current at 24 V (typically)</td>
<td>72 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150 mA with short circuit at the output of PROFIBUS</td>
</tr>
<tr>
<td></td>
<td>! IMPORTANT!</td>
<td>Continuous short circuit may cause device damage</td>
</tr>
<tr>
<td></td>
<td>Power Consumption</td>
<td>1,8 W</td>
</tr>
<tr>
<td></td>
<td>Connector</td>
<td>Mini-COMBICON, 2 pin</td>
</tr>
<tr>
<td>Environmental conditions</td>
<td>Temperature range</td>
<td>0 ... + 60 °C</td>
</tr>
<tr>
<td></td>
<td>Humidity</td>
<td>no condensation allowed</td>
</tr>
<tr>
<td>Device</td>
<td>Dimensions (L x W x H)</td>
<td>100 x 26 x 66 mm (without connector)</td>
</tr>
<tr>
<td></td>
<td>Weight</td>
<td>appr. 80 g</td>
</tr>
<tr>
<td></td>
<td>Mounting</td>
<td>on DIN rail EN 60715</td>
</tr>
<tr>
<td></td>
<td>Protection Class</td>
<td>IP 20</td>
</tr>
<tr>
<td></td>
<td>RoHS</td>
<td>Yes</td>
</tr>
<tr>
<td>CE Sign</td>
<td>CE Sign</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Emission</td>
<td>CISPR 11 Class A</td>
</tr>
<tr>
<td></td>
<td>Immunity</td>
<td>EN 61131-2:2003</td>
</tr>
<tr>
<td>Configuration</td>
<td>Software</td>
<td>SyCon oder IBHnet Treiber</td>
</tr>
</tbody>
</table>

Table 25: Technical Data NT 50-MPI (Part 2)
RFC 1006 is a standard for communication over TCP/IP that is supported by the MPI device. Via RFC 1006 the S7 communication protocol is transferred. The S7 communication protocols transparently for the MPI device.

**Application:**
PC-based visualization systems can be coupled by the netLINK to an S7 in order to read and write data.
RFC 1006 provides a point-to-point connection from the PC to the automation device.
The RFC 1006 uses a rack and a slot number for addressing. These are directly converted to the MPI address.
In order to access MPI address 2 you need to use the value 0 for the rack number and 2 for the slot number on the side of RFC 1006, for precise assignment see the table below. Some visualization software needs the TSAP. The assignment is listed in the following table.

<table>
<thead>
<tr>
<th>MPI</th>
<th>Rack</th>
<th>Slot</th>
<th>TSAP</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0200</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0201</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0202</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>31</td>
<td>0</td>
<td>31</td>
<td>021F</td>
</tr>
<tr>
<td>32</td>
<td>1</td>
<td>0</td>
<td>0220</td>
</tr>
<tr>
<td>33</td>
<td>1</td>
<td>1</td>
<td>0221</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>63</td>
<td>1</td>
<td>31</td>
<td>023F</td>
</tr>
<tr>
<td>64</td>
<td>2</td>
<td>0</td>
<td>0240</td>
</tr>
<tr>
<td>65</td>
<td>2</td>
<td>1</td>
<td>0241</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>95</td>
<td>2</td>
<td>31</td>
<td>025F</td>
</tr>
<tr>
<td>96</td>
<td>3</td>
<td>0</td>
<td>0260</td>
</tr>
<tr>
<td>97</td>
<td>3</td>
<td>1</td>
<td>0261</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>126</td>
<td>3</td>
<td>30</td>
<td>027E</td>
</tr>
</tbody>
</table>

*Table 26: Relation of MPI Address to Rack and Slot Number and TSAP*
12 Error Codes

12.1 TCP/IP Error Codes

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10013</td>
<td>Permission denied</td>
</tr>
<tr>
<td>10024</td>
<td>Too many open sockets.</td>
</tr>
<tr>
<td>10048</td>
<td>Address already in use</td>
</tr>
<tr>
<td>10049</td>
<td>Cannot assign requested address.</td>
</tr>
<tr>
<td>10050</td>
<td>Network is down</td>
</tr>
<tr>
<td>10051</td>
<td>Network is unreachable</td>
</tr>
<tr>
<td>10052</td>
<td>Network dropped connection on reset</td>
</tr>
<tr>
<td>10053</td>
<td>Software caused connection abort. An established connection was aborted by the software in your host machine, possibly due to a data transmission time-out or protocol error.</td>
</tr>
<tr>
<td>10054</td>
<td>Connection reset by peer</td>
</tr>
<tr>
<td>10055</td>
<td>No buffer space available</td>
</tr>
<tr>
<td>10056</td>
<td>Socket is already connected</td>
</tr>
<tr>
<td>10057</td>
<td>Socket is not connected.</td>
</tr>
<tr>
<td>10058</td>
<td>Cannot send after socket shutdown</td>
</tr>
<tr>
<td>10060</td>
<td>Connection timed out</td>
</tr>
<tr>
<td>10061</td>
<td>Connection refused</td>
</tr>
<tr>
<td>10065</td>
<td>No route to host</td>
</tr>
<tr>
<td>10092</td>
<td>Winsock.dll version out of range</td>
</tr>
</tbody>
</table>

Table 27: TCP/IP Error Code – Standard Win32 Socket API Error Codes

12.2 netIdent Error Codes

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x8004c701</td>
<td>Unknown Device Error</td>
</tr>
<tr>
<td>0x8004c702</td>
<td>Request Pending</td>
</tr>
<tr>
<td>0x8004c703</td>
<td>Set IP time exceeded</td>
</tr>
<tr>
<td>0x8004c704</td>
<td>IP address invalid</td>
</tr>
<tr>
<td>0x8004c705</td>
<td>Returned IP address invalid</td>
</tr>
<tr>
<td>0x8004c706</td>
<td>Answer from wrong device</td>
</tr>
<tr>
<td>0x8004c707</td>
<td>Wrong OP code received</td>
</tr>
<tr>
<td>0x8004c708</td>
<td>NetIdent Timeout</td>
</tr>
</tbody>
</table>

Table 28: netIdent Error Codes
### 12.3 PROFIBUS-FDL Error Codes

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (00H)</td>
<td>CON_OK Positive acknowledgement: Transmission of data from the sending (local) station completed.</td>
</tr>
<tr>
<td>1 (01H)</td>
<td>CON_UE Negative acknowledgement: Remote-User/FDL interface error.</td>
</tr>
<tr>
<td>2 (02H)</td>
<td>CON_RR Negative acknowledgement: No remote resources available.</td>
</tr>
<tr>
<td>3 (03H)</td>
<td>CON_RS Negative acknowledgement: No Service or no remote address at remote SAP activated.</td>
</tr>
<tr>
<td>4 (04H)</td>
<td>CON_RA Negative acknowledgement: Access-point blocked.</td>
</tr>
<tr>
<td>8 (08H)</td>
<td>CON_DL Positive acknowledgement for sent data (L_SDU), reply data with low priority available.</td>
</tr>
<tr>
<td>9 (09H)</td>
<td>CON_NR Positive acknowledgement for sent data, negative acknowledgement for reply data, as not available to the remote FDL controller.</td>
</tr>
<tr>
<td>10 (0AH)</td>
<td>CON_DH Positive acknowledgement for sent data (L_SDU), reply data with high priority available.</td>
</tr>
<tr>
<td>12 (0CH)</td>
<td>CON_RD Negative acknowledgement for sent data (L_SDU), resource of the remote FDL controller not available or not sufficient, reply data with low priority available.</td>
</tr>
<tr>
<td>13 (0DH)</td>
<td>CON_RDH Negative acknowledgement for sent data (L_SDU), resource of the remote FDL controller not available or not sufficient, reply data with high priority available.</td>
</tr>
<tr>
<td>16 (10H)</td>
<td>CON_LS Service at local SAP or local SAP not activated.</td>
</tr>
<tr>
<td>17 (11H)</td>
<td>CON_NA No reaction (acknowledgement/response) from remote station.</td>
</tr>
<tr>
<td>18 (12H)</td>
<td>CON_DS Local FDL/PHY not in token ring.</td>
</tr>
<tr>
<td>19 (13H)</td>
<td>CON_NO Negative acknowledgement: Not ok (different meanings dependent on service). No reply data transmitted.</td>
</tr>
<tr>
<td>20 (14H)</td>
<td>CON_LR Resource of the local FDL controller not available or not sufficient.</td>
</tr>
<tr>
<td>21 (15H)</td>
<td>CON_IV Invalid parameter in request - illegal parameters in the request header or - local station is passive or - destination station is own station address</td>
</tr>
<tr>
<td>23 (17H)</td>
<td>CON_NM Notice.</td>
</tr>
<tr>
<td>24 (18H)</td>
<td>CON_NC Reaction from only one station.</td>
</tr>
<tr>
<td>25 (19H)</td>
<td>CON_NP No plausible reaction from remote station.</td>
</tr>
<tr>
<td>26 (1AH)</td>
<td>CON_NL Local configurator variable is set.</td>
</tr>
<tr>
<td>27 (1BH)</td>
<td>CON_RD Reply data available.</td>
</tr>
<tr>
<td>32 (20H)</td>
<td>CON_LO Low prior response data are sent at this SRD.</td>
</tr>
<tr>
<td>33 (21H)</td>
<td>CON_HI High prior response data are sent at this SRD.</td>
</tr>
<tr>
<td>34 (22H)</td>
<td>CON_NO_DATA No data are sent at this SRD.</td>
</tr>
</tbody>
</table>
## 12.4 PROFIBUS-MPI Error Codes

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>48 (30H)</td>
<td>CON_TO</td>
</tr>
<tr>
<td></td>
<td>Timeout, the request message was accepted but no indication is sent back by the remote station. MPI protocol error, or station not present.</td>
</tr>
<tr>
<td>57 (39H)</td>
<td>CON_SE</td>
</tr>
<tr>
<td></td>
<td>Sequence fault, internal state machine error. Remote station does not react like awaited or a reconnection was retried while connection is already open or device has no SAPs left to open connection channel</td>
</tr>
<tr>
<td>133 (85H)</td>
<td>REJ_IV</td>
</tr>
<tr>
<td></td>
<td>Specified offset address out of limits or not known in the remote station. Check msg.data_adr if present or offset parameter in request message</td>
</tr>
<tr>
<td>134 (86H)</td>
<td>REJ_PDU</td>
</tr>
<tr>
<td></td>
<td>Wrong PDU coding in the MPI response of the remote station.</td>
</tr>
<tr>
<td>135 (87H)</td>
<td>REJ_OP</td>
</tr>
<tr>
<td></td>
<td>Specified length to write or to read results in an access outside the limits. Check msg.data_cnt length in request message.</td>
</tr>
<tr>
<td>136 (88H)</td>
<td>REJ_HW</td>
</tr>
<tr>
<td></td>
<td>Specified address not defined in the remote station. Check msg.data_request message</td>
</tr>
<tr>
<td>137 (89H)</td>
<td>REJ_MODE</td>
</tr>
<tr>
<td></td>
<td>MPI remote station not in the right operational mode. Bring S7 into RUN-P Mode.</td>
</tr>
</tbody>
</table>

*Table 30: PROFIBUS-MPI Error Codes*
13 Appendix

13.1 Device Labeling

13.1.1 NT 50-MPI

- MAC address of the Ethernet interface
- Identification Label
- Manufacturer logo
- Typical supply voltage
- Maximum ambient temperature
- Serial number
- Hardware revision number
- Part number
- Internet address of manufacturer
- Device name

13.1.2 NL 50-MPI

- MAC address of the Ethernet interface
- Matrix label with manufacturing information
- Serial number
- Hardware Revision
- Part number of the NL 50-MPI
13.2 Disposal of Waste Electronic Equipment


Waste Electronic Equipment
- This product must not be treated as household waste.
- You must dispose the device at a designated waste electronic equipment collecting point.

Waste electronic equipment may not be disposed of with household waste. As a consumer you are legally obliged to dispose all Waste electronic equipment professionally, as to the public collection.
14 Appendix

14.1 List of Figures

Figure 1: Dimensioned Drawing NL 50-MPI and NT 50-MPI (Size in mm) 19
Figure 2: Connections and LEDs NL 50-MPI and NT 50-MPI 20
Figure 3: PROFIBUS Interface X11 (D-Sub male connector, 9 pin) 22
Figure 4: PROFIBUS Interface X2 (D-Sub female connector, 9 pin) 22
Figure 5: netLINK NL 50-MPI, Coupling (Hardware Revision 4) 24
Figure 6: netTAP NT 50-MPI, Coupling 25
Figure 7: Mounting the netLINK 26
Figure 8: Mounting the netTAP NT 50 device onto the top-hat rail 26
Figure 9: Removing the NT 50 device from the Top-Hat Rail 27
Figure 10: Menu of the DVD Autostart 29
Figure 11: Install IP Driver (1) 30
Figure 12: Install IP Driver (2) 31
Figure 13: Install IP Driver (3) 31
Figure 14: NetIdent Demo 32
Figure 15: netIdent – Scan for Devices (1) 32
Figure 16: netIdent – Scan for Devices (2) 33
Figure 17: netIdent - Set IP Address 33
Figure 18: netIdent - Set IP Address (2) 33
Figure 19: netIdent - Set IP Address (3) 34
Figure 20: netIdent - Set IP Address (4) 34
Figure 21: GUI of the Hilscher IP Driver Setup 35
Figure 22: System Configurator SyConMPI – Create a new Project 38
Figure 23: Insert Device 38
Figure 24: System Configurator SyConMPI – The MPI Device is displayed in the Project 39
Figure 25: Set IP Address 39
Figure 26: Ethernet Parameters are detected automatically by the MPI Device 40
Figure 27: Set the PROFIBUS Parameters 40
Figure 28: Window Driver Select 41
Figure 29: Window Driver Select 41
Figure 30: Window Device Assignment ODM TCP/IP Driver 42
Figure 31: Window Device Assignment ODM TCP/IP Drive – Found devices are displayed 42
Figure 32: Window Configure IP Address 43
Figure 33: Window Configure IP Address – Set the IP address 43
Figure 34: Hint – Setting IP Address successful 43
Figure 35: Window Device Assignment ODM TCP/IP Drive – A Connection has been established 44
Figure 36: Online Configuration Download 45
Figure 37: Question – Do you really want to download? 45
Figure 38: Progress Bar Data Base Download 45
Figure 39: Window Firmware/Reset 46
Figure 40: Question – Do you really want to reset the firmware? 46
Figure 41: Settings > MPI Device Parameter > IP Address 47
Figure 42: Settings > NetLink Parameter > Ethernet 48
Figure 43: Settings > MPI Parameters > PROFIBUS 49
Figure 44: Settings > MPI Parameters > PROFIBUS > Autobaud 51
Figure 45: Question – Do you really want to download? 52
Figure 46: Window Firmware Copy/Download 53
Figure 47: Question – Do you really want to download the firmware? 53
Figure 48: Progress Bar Data Base Download 54
14.2 List of Tables

Table 1: List of Revisions 5
Table 2: Reference to Hardware 6
Table 3: Reference to Firmware 6
Table 4: Reference to SyConMPI Software 6
Table 5: Directory Structure of the DVD 7
Table 6: Documentations for Users 8
Table 7: Documentations for Developers 8
Table 8: Safety Symbols and Sort of Warning or Principle 13
Table 9: Signal Words 13
Table 10: Signal Words according to ANSI 13
Table 11: Ethernet RJ45 Pin Assignment 21
Table 12: Ethernet Connection Data 21
Table 13: PROFINET Interface (D-Sub female and male connector, 9 pin) 22
Table 14: Supply Voltage Pin Assignment 23
Table 15: Coupling NL 50-MPI, Hardware Revision 4 24
Table 16: Coupling NT 50-MPI 25
Table 17: Configuring IP Driver 35
Table 18: Baud rates and Bit times 49
Table 19: Names and Meaning of LED 57
Table 20: Meaning of LED-Signals 57
Table 21: Display Status 58
Table 22: Technical Data netLINK NL 50-MPI (Part 1) 59
Table 23: Technical Data NL 50-MPI (Part 2) 60
Table 24: Technical Data NT 50-MPI (Part 1) 61
Table 25: Technical Data NT 50-MPI (Part 2) 62
Table 26: Relation of MPI Address to Rack and Slot Number and TSAP 63
Table 27: TCP/IP Error Code – Standard Win32 Socket API Error Codes 64
Table 28: netIdent Error Codes 64
Table 29: PROFIBUS-FDL Error Codes 65
Table 30: PROFIBUS-MPI Error Codes 66
14.3 Contacts

Headquarters

Germany
Hilscher Gesellschaft für Systemautomation mbH
Rheinstrasse 15
65795 Hattersheim
Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-Mail: info@hilscher.com

Support
Phone: +49 (0) 6190 9907-99
E-Mail: de.support@hilscher.com

Subsidiaries

China
Hilscher Systemautomation (Shanghai) Co. Ltd.
200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-Mail: info@hilscher.cn

Support
Phone: +86 (0) 21-6355-5161
E-Mail: cn.support@hilscher.com

France
Hilscher France S.a.r.l.
69500 Bron
Phone: +33 (0) 4 72 37 98 40
E-Mail: info@hilscher.fr

Support
Phone: +33 (0) 4 72 37 98 40
E-Mail: fr.support@hilscher.com

India
Hilscher India Pvt. Ltd.
New Delhi - 110 025
Phone: +91 11 40515640
E-Mail: info@hilscher.in

Italy
Hilscher Italia srl
20090 Vimodrone (MI)
Phone: +39 02 25007068
E-Mail: info@hilscher.it

Support
Phone: +39 02 25007068
E-Mail: it.support@hilscher.com

Japan
Hilscher Japan KK
Tokyo, 160-0022
Phone: +81 (0) 3-5362-0521
E-Mail: info@hilscher.jp

Support
Phone: +81 (0) 3-5362-0521
E-Mail: jp.support@hilscher.com

Korea
Hilscher Korea Inc.
Suwon, 443-734
Phone: +82 (0) 31-695-5515
E-Mail: info@hilscher.kr

Support
Phone: +82 (0) 31-695-5515
E-Mail: kr.support@hilscher.com

Switzerland
Hilscher Swiss GmbH
4500 Solothurn
Phone: +41 (0) 32 623 6633
E-Mail: info@hilscher.ch

Support
Phone: +49 (0) 6190 9907-99
E-Mail: ch.support@hilscher.com

USA
Hilscher North America, Inc.
Lisle, IL 60532
Phone: +1 630-505-5301
E-Mail: info@hilscher.us

Support
Phone: +1 630-505-5301
E-Mail: us.support@hilscher.com

Support